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ii.  

 

Overview of Nutrition A3 
 

Nutrition A3 (Anytime, Anywhere, Anyplace) offers a fun, project-based approach that engages 

teens with technology and empowers them to make healthy food choices and be physically 

active. Six Nutrition A3 projects focus on increasing evidence-based behaviors that can improve 

student wellness. Projects challenge teens to evaluate their own lifestyle habits, take steps to 

improve their habits and measure their success. Students practice an interdisciplinary range of 

skills to tackle technology-enhanced projects from mapping “physical activity zones” in their 

community to producing their own cooking show.   

 

Nutrition A3 projects are suitable for the classroom and in after-school programs for teens. They 

can be used independently or as an extension to Nutrition Essentials: Teaching Tools for Healthy 

Choices and Empowering Youth – USDA Team Nutrition educational programs available at 

http://teamnutrition.usda.gov.   

 

There are six evidence-based objectives for the Nutrition A3 projects, which include encouraging 

teens to: 

 use MyPyramid to plan their daily food choices,  

 increase physical activity,  

 enjoy more fruits and vegetables,  

 fuel up with less fat,  

 decrease screen time,   

 choose less sweetened beverages.  

 

The Nutrition A3 projects for teens are available via the icollaboratory.org website (free 

registration is required) and each contains several activities. After a brief introduction to the 

targeted behavior, a short survey starts students thinking about their current lifestyle choices. 

After taking the survey, they are asked to share their observations and ideas on the topic in the 

forum. This is followed by independent or group activities focused on improving their healthy 

choices. Projects have mini-quizzes to check the students’ understanding of the topic, and polls 

and forums where students share their ideas or projects. Each project ends with another survey to 

measure any changes in intended behavior. 

 

The Nutrition A3 projects assist teachers in integrating technology and addressing Illinois 

Learning Standards and No Child Left Behind goals. In addition, Nutrition A3 will help schools 

meet school wellness policy requirements for nutrition education. The Nutrition A3 projects will 

be particularly useful to family and consumer science, health and after-school teachers at middle 

school and high school level and can be integrated into core curriculum from language arts to 

science.   

 

Students create PSAs, web pages, a teen advice column, community activity zone maps, a 

cooking show and more in Nutrition A3 projects. These projects can be used by teen advocacy 

groups and school wellness teams to bring about positive change in the school community. The 

possibilities are endless! 

http://teamnutrition.usda.gov/
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Illinois Learning Standards 

Addressed through Nutrition A3 Projects 
 

Nutrition A3 

Project 

English-Language Arts  

and Literacy 

Mathematics Physical 

Development 

& Health 

Fine 

Arts 

Applications of Learning 

Project 1: Getting 

Started with MyPyramid 
 

X 

 

 

 

X 

 -Solving problems 

-Communicating 

-Using Technology 

-Making Connections 

Project 2:  

Get Moving! 
 

X 

 

X 

 

X 

 -Solving problems 

-Communicating 

-Using Technology 

-Working in Teams 

-Making Connections 

Project 3: 

Fun with Fruits and 

Veggies 

 

X 

  

X 

 

X 

-Solving problems 

-Communicating 

-Using Technology 

-Working in Teams 

-Making Connections 

Project 4: 

Eat to Win: Fueling Up 

with Less Fat 

 

X 

 

X 

 

X 

 

X 

-Solving problems 

-Communicating 

-Using Technology 

-Working in Teams 

-Making Connections 

Project 5:  

From Screen Time to Fun 

Time 

 

X 

 

X 

 

X 

 

X 

-Solving problems 

-Communicating 

-Using Technology 

-Working in Teams 

-Making Connections 

Project 6:  

Rate Your Beverage 

Choices 

 

X 

 

X 

 

X 

 -Solving problems 

-Communicating 

-Using Technology 

-Making Connections 
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Nutrition A3 
Teacher Quick Start Tips 

 

To create teacher username and password  
1. Go to www.icollaboratory.org.    

2. Select Create Account under the login link on the left navigation bar (this is free)  

3. Enter required information marked with an asterisk (*) and click Submit.  FYI—

iCollaboratory will email you within 48 hours that your information has been entered. 
  

To login 
1. Go to www.icollaboratory.org.   

2. Select Login.   

3. In the Login box, enter Username and Password. Click Login.   

4. Locate Nutrition A3 under Course Categories.   

5. Select Nutrition A3 Teacher eCourse* if you are a first time user or select desired 

Nutrition A3 project and begin activities. 
 

*Earn 4 CPDUs and a free classroom poster by completing the eCourse.      
 

To create student iCollaboratory accounts 

Create a spreadsheet in Microsoft Excel and save it as a .csv file (not .xlsx).  The spreadsheet 

table should contain a username, password, first name, last name and email.  Do not use 

commas.   
 

 Please start your student IDs with s- to indicate they are students. To ensure their names 

are not duplicated, add a number at the end of students’ login name. 

 

 Passwords need to be secure. Do not give each student the same password.  

 

 Student names should include his/her first name and the first initial of his/her last name.  
 

For example, Jerry Smith is JerryS, if there is a second Jerry Smith he should be 

JerrySm.  

 

 A student's last name should be his/her school name.  
 

For example, Jerry Smith from Hayt School from district 204 would be JerryS Hayt 

School. His login name might be jsmith204 or jsmith204hayt.  
 

 Each student must have a unique email address, but, iCollaboratory does not want an 

official email address.   

 

For example, if your email address is lsmentek@cps.edu, the students’ email addresses 

will be lsmentek1@hayt.cps.edu, lsementek2@hayt.cps.edu, lsmentek3@hayt.cps.edu, 

etc…   
 

 DO NOT use commas anywhere in the file. 
 

 

 

http://www.icollaboratory.org/
http://www.icollaboratory.org/
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Spreadsheet example 
Username Password First Name Last Name Email 

s-jerrys204hayt yell..low JerryS Hayt-School lsmentek1@hayt.cps.edu 

s-jerrysm204hayt pen12cil JerrySm Hayt-School lsmentek2@hayt.cps.edu 

s-johnsmi204hayt prupple3 JohnSmi Hayt-School lsmentek3@hayt.cps.edu 
 

For questions on setting up student iCollaboratory accounts, contact icollaboratory@gmail.com.  

 

Technology used in NutritionA3 
Moodle 

Nutrition A3 uses the free Moodle course management software.  The Nutrition A3 projects use 

several basic features of Moodle including forums, quizzes, polls and resources. To expand your 

knowledge of Moodle, visit http://docs.moodle.org/en/Teacher_documentation.  
 

Google Apps 

The students will be using free Google Apps for creating word processing documents, websites, 

and spreadsheets for each project.  How-to documents provide teachers and students with 

instructions or visit www.google.com/apps for more information.  Links to the how-to 

documents can be found in each NA3 activity and in the resources listed at the end of each 

project.   
 

Students working in teams can collaborate on assignments using Google. To do this, they simply 

invite their teammates to view and edit their document. 

 

Prior to starting each Nutrition A3 project be sure to:  
 Arrange access to a computer lab and Internet. 

 Become familiar with and test each activity on school computers to make sure it works 

with the school’s Internet filters.  You may need to work with your school’s technology 

coordinator to resolve any issues.        

 Add discussion topic to each forum within the projects so students know where to post 

their ideas and projects.   

1. Go to the desired Nutrition A3 Project page and click on title of desired forum.  

2. Click on Add a discussion topic. 

3. In Subject box, enter the title discussion topic.  Be sure to choose a name 

reflective of the project and your class name/period.       

4. In the message, provide specific instructions for your class. 

5. Click Post to forum.   

 Locate resources for NA3 projects listed below.  
 

Project 3:  

 Video camera  

 Food for recipes 

 Food lab or kitchen 

 Set up Teacher Tube account at 

www.teachertube.com.    

Project 4 

 Digital camera  

 

 

Project 6 

 Sugar cubes (1-2 boxes) 

 Plastic bags (1 per student) 

 Computer microphone  

 Install recording software  like 

Audacity (free)

mailto:icollaboratory@gmail.com
http://docs.moodle.org/en/Teacher_documentation
http://www.google.com/apps
http://www.teachertube.com/


 

4 | P a g e  
 

 

 

Nutrition A3 
Technology 

How-To Documents 



 

5 | P a g e  
 

 
About Google Word Processor Documents 

 

To create a document in Google Docs 

1. Click the Docs ( ) link in the Google Apps block (on right-hand side of project page). 

2. Click the New button.  

3. Select Document.  

 

To rename the document  
1. Click on the File drop-down menu.  

2. Select Rename. 

3. Enter new document name and click OK.   

 

To enter content into your document 
1. Click in the main body of the document and begin typing.     

 

To insert a picture into your document 
2. Click the Insert drop-down menu and select Image.  

3. Choose Upload (if it is from your computer) or URL (if it from a website).   

4. Browse to the image on your computer and double-click to insert OR insert the URL for 

the image and select Insert.   

 

To create a copy and edit a document 
1. Select the title of the document in the Nutrition A3 Project to be copied.   

2. Click the File drop-down menu and select Make a Copy.  

3. A pop-up box will appear asking if you want to create a new copy of the document. 

Select OK.   

4. Click the File drop-down menu and select Rename. 

5. A pop-up box will appear asking you to enter a new document name.  

6. Click OK and renamed document will appear.    

7. Begin to make edits within document.   

 

To share document URL and post in a forum 
1. Click on Share, then Sharing settings. 

2. Change share settings to iCollaboratory and click Save.  

3. Copy and paste document URL into your reply in the forum.    
4. Enter a title and a description for your document in your reply.   

5. Click Post to Forum.   

 

 

For more help, see the Google Doc Help pages. 

http://docs.google.com/support/bin/topic.py?hl=en&topic=15114
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About Google Spreadsheets 
 

To open, download and name spreadsheet as Excel file 
1. Click the link for the spreadsheet. 

2. Click the File drop-down menu. 

3. Click Download as and select Excel 

4. Select Open and the spreadsheet will open in Microsoft Excel.   

5. Click the Save As icon, select desired location and enter name for spreadsheet.    

6. Add desired content. 

7. Click Upload in Google Docs window.  

8. Click Select Files to upload.   

9. Navigate to your spreadsheet.   

10. Select spreadsheet and click on it to start upload.    
 

To create, name new Google spreadsheet and post in a forum 

1. Click the Docs ( ) link in the Google Apps block (on right-hand side of project page). 

2. Click the Create New button.  

3. Select Spreadsheet.  

4. To name spreadsheet, click on the File drop-down menu and select Rename.  

5. Enter new spreadsheet name and click OK.   
6. Enter content into spreadsheet.  
7. Click Share, then Sharing settings. 

8. Change share settings to iCollaboratory and click Save.  

9. Copy and paste spreadsheet URL into your reply in the forum.    
10. Enter a title and a description for your spreadsheet in your reply.   

11. Click Post to Forum.   
 

To create rows and columns in spreadsheet 
 

 See the Google Docs Help Pages on Rows and columns  
 

To sum elements in the rows and columns 
 

 See the Google Docs Help Pages on Quick Sum  
  

 See the Google Docs Help Pages on Formulas 
 

To upload Excel spreadsheet and post in a Forum 

1. Click the Docs ( ) link in the Google Apps block (on right-hand side of project page). 

2. Click Upload. 

3. Click Select files to upload. NOTE: You can upload files up to 1024 MB. 

4. Select file and click on Start upload.  

5. Open the file uploaded. 

6. Click Share, then Sharing settings. 

7. Change share settings to iCollaboratory and click Save.  

8. Copy and paste spreadsheet URL into your reply in the forum.    
9. Enter a title and a description for your spreadsheet in your reply.   

http://docs.google.com/support/bin/topic.py?hl=en&topic=15156
http://docs.google.com/support/bin/answer.py?hl=en&answer=66032
http://docs.google.com/support/bin/topic.py?hl=en&topic=15164
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10. Click Post to Forum.   
 

For more help, see the Google Doc Help pages. 

http://docs.google.com/support/bin/topic.py?hl=en&topic=15114
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How to Upload and Share Student Videos  
  

1. Click the Docs ( ) link in the Google Apps block (on right-hand side of project page). 

2. Click Upload. 

3. Click Select files to upload. 

4. Select video file and click on Start upload. NOTE: You can upload files up to 1024 MB.  

5. Open the file uploaded. 

6. Click Share, then Sharing settings. 

7. Change share settings to iCollaboratory and click Save.  

8. Copy and paste video URL into your reply in the forum.    
9. Enter a title and a description for your video in your reply.   
10. Click Post to Forum.   

How to Share Your Photo in the Forum 
 

Please set your digital camera on the lowest resolution or size setting before taking the 

photo. The photo can be no larger than 400 x 600 image resolution to share in the Forum.  
 

1. Click the Docs ( ) link in the Google Apps block (on right-hand side of project page). 

2. Click Upload. 

3. Click Select files to upload. NOTE: You can upload files up to 1024 MB. 

4. Select photo file and click on Start upload.  

5. Open the file uploaded. 

6. Click Share, then Sharing settings. 

7. Change share settings to iCollaboratory and click Save.  

8. Copy and paste photo URL into your reply in the forum.    

9. Enter the name of your food (ex. graham crackers) in the Subject field.   
10. Click Post to Forum.   

How to Create and Share a Google Site (Website) 
 

1. Click the Sites ( ) link in the Google Apps block (right-hand side of page).   

2. Click Create New Site button.  

3. Type in a name for your website in Name your Site box.  

4. Click Choose a theme and select background.   

5. Click More Options.   

6. Enter nutrition in Site Categories box.   

7. Enter a brief description in Site Description box.   

8. Select Collaborate with everybody at iCollaboratory.   

9. Click Create Site button.  A template of your site will be created.   
10. Copy and paste Google Site URL into your reply in the forum.    
11. Enter a title and a description for your Google Site.   
12. Click Post to Forum.   
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To enter content in your webpage, watch the Google Sites Overview video or visit the 

Google Sites Help.

http://www.youtube.com/watch?v=fD-4FRTzxkI&eurl=http%3A%2F%2Fwww.google.com%2Fsites%2Fhelp%2Fintl%2Fen%2Foverview.html&feature=player_embedded
http://www.google.com/support/sites/


 

10 | P a g e  
 

 

How to Create and Share a Scribble Map 
 

To start this activity 
1. Go to www.scribblemaps.com.  An instruction box will be in the center of the page. Click 

the “X” in the upper right corner to close the box.   

2. In the box in the upper left-hand corner, type in your city and state and hit Enter to 

quickly locate your region.   

3. Type in the addresses of the locations you wish to add your map and hit Enter.   

To add a place marker to your Scribble Map 
1. Click the Place Marker tool (located at top of the page). 

2. Select the appropriate place marker from the Category box (lower right corner).  

3. Place the marker in the appropriate location and left-click on your mouse.  

4. Type in title and description of the location.   

5. Click Save.  

  

To add a path to your Scribble Map 
1. Click the Draw Lines tool (located at the top of the page).  

2. Left-click on your mouse where the path begins.   

3. Holding down the left mouse button, drag the line and left-click where the path ends.   

4. To change the path color, click on the color square (top of page) and select color.   

 

To remove an element from your Scribble Map 
1. Click the Eraser tool (located at the top of page).  

2. Roll the eraser over the element (place marker or path) to be removed until it is 

highlighted.   

3. Click on the element to remove it.   

 

To read the name of a marked location 
1. Click the Select tool (located at the top of the page). 

2. Roll the arrow over the place marker and left-click.   

3. Click the “X” at the upper right corner to close the box.   

 

To obtain the URL of your Scribble Map and post (share) to forum  
1. Select Save from the Menu tab.   

2. Enter a title and description for your Scribble Map and click Save.   

3. A pop-up box will open titled Save Map.  Enter a password.  NOTE:  Be sure to write 

down this password in case you want to make edits. Click Save.   

4. A pop-up box will open titled Map Saved, which provides your Scribble Map URL.   

5. Share the map URL in the forum.   

http://www.scribblemaps.com/
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How to Record and Upload Your PSA 
 

You will need a microphone hooked up to the computer and software for recording and 

editing audio files for this project.   

 

1. Select an audio software that can record audio files as .mp3.   
 

NOTE: If you do not have audio recording software, you can download the Audacity 

software.  Audacity is a free, open source software for recording and editing sounds. It 

is available for Mac OS X, Microsoft Windows, GNU/Linux, and other operating 

systems. 
 

2. Record and edit the PSA.  Use the help feature of your software for detailed recording 

and editing instructions.   
 

3. Save the PSA file as an .mp3 or .wav.  
 

NOTE: To export files as .mp3 or .wav, Audacity requires LAME MP3.  For detailed 

instructions on how to install this program, click here. 
 

4. Click the Docs ( ) link in the Google Apps block (on right-hand side of project page). 

5. Click Upload. 

6. Click on Select files to upload. NOTE: You can upload files up to 1024 MB. 

7. Select file and click Start upload.  

8. Open the file uploaded. 

9. Click Share, then Sharing settings. 

10. Change share settings to iCollaboratory and click Save.  

11. Copy and paste PSA URL into your reply in the forum.    

12. Enter a title and a description for your PSA in your reply.   

13. Click Post to Forum.   

 

 

 

 

http://audacity.sourceforge.net/
http://audacity.sourceforge.net/help/

